Clarity PPM 15.7.1| Resolved Defects
The following customer reported issues were resolved in the following release:
(52 fixes) December 16, 2019 Clarity PPM 15.7.1 Minor Release
Note: For additional updates apply the latest patch for your release
Learn more at https://techdocs.broadcom.com
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DE49721
Minor
Found in 15.6.1
Fixed in 15.7.1

Unable to create virtual attributes from Sub objects associated with an Investment Object such as
Project

SUMMARY: Unable to create virtual attributes on sub objects associated with any investment objects
including sub objects: Task, Team, Risk. Error generated: ERROR System error. Contact system
administrator. So far, this issue appears to be centralized to any sub objects associated with an investment
object such as Idea, Investment, Project. This issue also happens for any custom sub objects created from
investment objects including Project, Idea, and Investment objects.
Objects that you are able to create virtual attributes from include: Assignment and Portfolio Plan, any custom
sub objects from non-investments such as the Portfolio Object.
STEPS TO REPRODUCE:
1. Create a calculated attribute on the Investment object
2. Make the formula a constant of 0
3. Click 'Save & Return' button
4. Try to create a new virtual attribute on the Task object
Expected Results: To see no error on the 'Object: Investment - Select Attributes of Referenced Items' page
with the Master Object field having a pull-down for listing all master objects available for selection to create
the virtual attribute.
Actual Results: The ability to create the virtual attribute is halted due to a system error on the 'Select
Attributes of Referenced Items' page. The master Object name is also missing from the title of the page.
DE49750
Major
Found in 15.4.1
Fixed in 15.7.1

Unable to filter on Virtual MVL attributes in Status Report object

SUMMARY: Unable to filter on Virtual MVL attributes in Status Report object.
STEPS TO REPRODUCE:
1. In Classic PPM, go to Administration, Objects
2. Click on the Status Report Object and go to the Attributes tab
3. Click the New Virtual Attribute button and select any item that has a type of Multi-valued Lookup - Number
4. Click the Add button
5. Give the attribute a name and id
6. Add the attribute to the Edit Layout view
7. Add the attribute to the Filter view
8. In Classic UI, go to a project and make sure the attribute has a couple of items selected
9. Add the attribute to the filter list
10.Create a status report if one does not exist
11.Try to filter for one or more of the values you chose
Expected Results: Filter should show the result available in the Status report object.
Actual Results: There is no result to display. (You can see the result in the list view if no filter is set, however
it does not appear once you hit filter.)

DE49920
Minor
Found in 15.6
Fixed in 15.7.1

Cost Plan grouping attributes have wrong German translation

SUMMARY: German translations for Cost Plan Grouping attributes are wrong. The Cost Type label is
showing the same label as the Charge Code translation.
STEPS TO REPRODUCE:
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1. Login to Clarity PPM as an admin user who is having Locale and Language both set as 'German'
2. Be sure to refresh browser, log out / log in again to ensure the translations are picked up
3. Go to STARTSEITE --> Portfolio Management --> Projekte
4. Open any of existing projects
5. Make sure the Department OBS is filled for that project
6. Click on 'Finanzpläne' tab
7. Click on the 'Neuer manuell erstellter Plan' button
8. Click on the binocular icon for 'Gruppierungsattribute' attribute
Expected Results: Labels for all the options should different - there should be the appropriate label for Cost
Type.
Actual Results: There are 2 options called "Kostenart" - the Cost Type translation is incorrect.
Workaround: None - The German user will be confused to see 2 labels the same but for different attributes.
One workaround would be to create the cost plan in another language so the labels appear correctly.
DE50561
Major
Found in 15.5.1
Fixed in 15.7.1

Modern UX Timesheet Notes Count Icon not showing when timesheet is created with many tasks
using Add Assigned Tasks option

SUMMARY: New User Experience (UX) Timesheet Notes Count Icon/Indicator not showing at task level
when timesheet is created with many tasks using Add Assigned Tasks option.
This part is still reproducible even with the fix for DE49389.
If you initially populate with only a few tasks and then add more tasks the issue does not occur.
If you remove tasks once the issue occurs, the tasks with the issue remain with the issue. However, if you
add a task back and enter a note on it the icon does show.
STEPS TO REPRODUCE:
Prerequisite: Make sure the timesheet user is assigned to at least 29 tasks in the time period the timesheet is
being created
1. In the New UX , go to a time period where a timesheet hasn’t yet been created
2. Check the check box for Add Assigned tasks (Make sure Copy Previous timesheet is unchecked)
Important: Make sure the user the timesheet is being created for is assigned to at least 29 tasks in the time
period the timesheet is being created
3. Click Create Timesheet
4. Click on the first task on the timesheet
5. Add a note in the Notes popup window and click Enter
Expected Result: Notes Count Icon Appears in the Notes popup window and also next to the task (next to
Submit). In the above example, it should show: 1.
Actual Result: Notes count Icon does not show in the Notes popup window or next to the task on the
Timesheet list.
Workarounds:
Option 1: Add notes to the top Notes section of the timesheet (button next to the Submit/Approve button).
Option 2: Remove any task you want to add a note to from the timesheet, then re-add the task to the
timesheet. Then, when you add a note the note icon will display.
Option 3: Use the + Work option to create a new timesheet, and initially only add less than 29 tasks to the
timesheet. Once the timesheet is created, if you add more tasks the issue will not occur.
DE50592
Minor
Found in 15.6.1
Fixed in 15.7.1

Not able to drag newly created cards on a Custom Investment

SUMMARY: Not able to drag card on Chrome, Firefox and Edge browser.
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STEPS TO REPRODUCE:
1. Login to Clarity PPM Modern UX
2. Click on a Custom Investment board
3: Create new card (saved record) and immediately try to drag that card
Expected Results: Should be able to drag card.
Actual Results: Not able to drag the newly created card.
Workaround: Refresh the page and drag the card.
DE50607
Minor
Found in 15.4
Fixed in 15.7.1

Transaction Entry - Vendor Browse not sorting

SUMMARY: Transaction Entry - Vendor Browse not sorting (Classic PPM).
STEPS TO REPRODUCE:
1. Login to Classic PPM
2. Go to Transaction Entry
3. Create a new transaction entry and click 'Save' button
4. Use the Vendor browse
Expected: It should have ability to sort ascending or descending, not random created order.
Actual: It does not sort ascending or descending.
Workaround: None. Filtering may accommodate a narrow listing using pattern matching from the filtering to
see items that begin with a specific pattern of letters.
DE50716
Cosmetic
Found in 15.6.1
Fixed in 15.7.1

Autonumbering ID is editable in Modern UX

SUMMARY: Idea ID editable in Modern UX when auto-number is enabled.
STEPS TO REPRODUCE:
1. Enable Auto-numbering in Studio on Idea Object for the ID field
2. Navigate to the Modern UX Ideas grid (pm/#/ideas/grid)
3. Click on the + icon to add new Idea in grid
4. Edit the ID field before opening the Idea form (while the row is still highlighted in yellow indicating the row
has not been created yet)
5. Open the Idea form and the ID field is locked and populated
Expected Results: To see an auto-numbered value appear in the field so the user is not led to trying to enter
a value in the field.
Actual Results: The field is empty and the user can edit the field with any value they want to - but after saving
the auto-numbered value comes up anyway.
Workaround: Skip the ID field when creating the record in the grid and once all other required fields are
updated, the record is created with the auto-numbered value.
Resolution: The field is now locked (cannot edit the field) when Auto-numbering is enabled.
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DE50728
Major
Found in 15.6
Fixed in 15.7.1

Timesheet cannot be approved for an Inactive User in the Modern UX with OBS Rights

SUMMARY: A user with 'Resource - Approve Time' at OBS level is unable to approve a submitted timesheet
for an inactive user in the Modern UX.
This does not happen if 'some_user' is active, or if 'approver_user' has global 'Timesheets - Approve All'.
STEPS TO REPRODUCE:
1. Create a group (e.g.: 'approver_test')
2. Add all possible Global Access Rights, EXCEPT 'Timesheets - Approve All'
3. Add OBS Unit Access Rights for 'Resource - Approve Time' for a given OBS only
4. Add user (e.g.: 'approver_user') to that group
5. Have another user (e.g.: 'some_user') be a member of that OBS (Resource OBS)
6. Make 'some_user' inactive
In the Classic UX Timesheet:
7. Find two timesheets for 'some_user' and submit them for approval
8. Approve the first timesheet
Expected & Actual Results: The timesheet is now approved
In the Modern UX Timesheet:
9. Find and click on 'Approve' for the earlier submitted timesheet
Expected Results: Timesheet is approved
Actual Results: Error is shown (Error updating the status for the timesheet)
app-ca.logs:
ERROR 2019-08-26 04:15:04,061 [http-nio-80-exec-175] rest.validation (clarity:admin:5459072__F8A3447A3071-438B-9C86-8AE83C472FE1:PPM_REST_API) ODFResourceProvider :: Could not update resource.
Object code alias: [ requestUrl: http://myhost/ppm/rest/v1/timesheets/5012005 , _restResourceName :
timesheets , _id : 5012005 , _parentInfo : null , _apiVersion : v1 , _includeLinksArray : true , _contextId : -1]
ERROR 2019-08-26 04:15:04,061 [http-nio-80-exec-175] rest.validation (clarity:admin:5459072__F8A3447A3071-438B-9C86-8AE83C472FE1:PPM_REST_API) ExceptionInfo :: Could not update resource. Resource
name: timesheets. Error code: timeadmin.TIMESHEET_APPROVE_RIGHTS Error message: TMA-0130:
You do not have approval rights for this timesheet.
Workaround: None.
DE49417
Cosmetic
Found in 15.6
Fixed in 15.7.1

Modern UX: Financial Cost Plan 'Copy' - Repopulating is not resetting the duration of the plan

SUMMARY: In the Modern UX, if you copy the Cost Plan and change the dates to shorten the duration of the
plan, repopulating the plan using 'Populate from Allocations' shows the full duration of the project in the Plan
Details, but the Plan Settings still shows the shortened duration. This does not happen in Classic. When the
plan repopulates, the plan dates show correctly on the properties page to reflect the full duration of the
project.
STEPS TO REPRODUCE:
1. In Modern UX go to a project and copy an existing Cost Plan
2. Change the dates to shorten the plan duration
3. Verify the Details Periods match the shortened plan dates
4. On the same Cost Plan - 'Populate from Allocations'
Expected Result: Plan Settings Dates expand to cover the Project duration dates and show these additional
periods in the Cost Plan Details.
Actual Result: Cost Plan Settings Dates remained the shortened dates, but the Cost Plan Details now show
all periods to cover the project duration.
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Workaround: The Cost Plan dates are not editable in this plan. Recreate the Cost Plan from Classic for this
specific use case to ensure the Cost Plan Dates are set correctly. Delete the incorrect Cost Plan.
DE49672
Major
Found in 15.6
Fixed in 15.7.1

OWB 2.1.2 (15.6.0.320) task properties picking wrong Task

SUMMARY: When testing the new OWB from Clarity 15.6 the following behavior has been observed in some
cases:
1. Start OWB (offline, no connect to server)
2. Open RMP-File
3. Open Task Properties for certain Task (double-click or context menu)
Expected Behavior: Task Property-Popup with data of selected Task.
Observed Behavior: Task Property-Popup showing data of other Task or empty task.
STEPS TO REPRODUCE:
1. Start OWB in Standalone Mode (do not connect to Clarity server)
2. Go into Task screen in OWB
3. Create an Excel spreadsheet and create approximately 25 tasks with this content:
Column A: type in ‘Phase’ or ‘Task’
Column B: type in an ID number, for example: SO2019-UE-0
Column C: type in any name for the task (or phase)
Column D: type in the start date, i.e 21/01/2019
Column E: type in the finish date, i.e 30/12/2019
4. Select all Data (Ctrl-A)
5. Copy to Clipboard (Ctrl-C)
6. In OWB Select the first cell in the first row
7. Paste (CTRL-V)
8. Try to select some Tasks, until you get an unwanted 'Multi-Select'
Expected Results: For the ‘Task Properties’ screen to appear for the selected task.
Actual Results: The ‘Task Properties’ screen to appears but its blank and you will see that several tasks are
selected, not just the one task.
Workaround: None.
DE50298
Major
Found in 15.6
Fixed in 15.7.1

Classic UX - Getting unauthorized access errors in Incidents area if the user does not have
'Timesheets - Edit All' access right

SUMMARY: Classic UX - Receiving an "Error 401 - Unauthorized" error when adding incidents and trying to
navigate through different pages or trying to sort by any column, if the user does not have 'Timesheets - Edit
All' access right.
STEPS TO REPRODUCE:
Prerequisite: The user you log in with to reproduce the issue does NOT have the global Timesheet -Edit -All
access right.
1. Ensure the PPM user you log in with is able to enter time against incidents
2. In Classic UI, go to the timesheets list
3. Click 'Add Task' button
4. Click the 'Name' column header to reorder the tasks by name or try to navigate to the following page if
more than one page is present (everything is okay)
5. Open a timesheet and click the 'Add Incident' button
6. Click the 'Name' column header to reorder the incidents by name or try to navigate to the following page if
more than one page is present

Expected Results: To be able to navigate through pages or reorder the columns for a user without global
access to edit all timesheets.
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Actual Results: Error 401 - Unauthorized. You are not authorized to view the page. If you are sure you have
access, try logging in again or contact your system administrator.
Workaround: Filter by the specific incident.
DE50648
Major
Found in 15.6
Fixed in 15.7.1

Current Time Period in Staffing Modern UX is honoring Calendar Periods instead of Fiscal Periods

SUMMARY: In the Modern UX under Staffing, the Current Time Period is honoring the Calendar Period and
not the Fiscal Period.
STEPS TO REPRODUCE:
1. Create an Entity and define the monthly fiscal periods as below
May 5, 2019-Jun 1, 2019
Jun 2, 2019-Jul 1, 2019
Jul 7, 2019-Aug 3, 2019
Aug 4, 2019-Aug 31, 2019
Sep 1, 2019-Sep 30, 2019
2. Navigate to the Modern UX - Staffing
3. On the Top Left corner, set the Start Period as CURRENT TIME PERIOD and close the pop up window
Note: The current date is 20th Aug 2019
Expected Results: The TSV cells starts from the fiscal period Aug 4, 2019-Aug 31, 2019.
Actual Results: The TSV cells starts from Jul 7, 2019-Aug 3, 2019.
Additional Info: The root cause is the Current Time Period setting is considering Calendar Period and not the
Fiscal period. Ideally, Current Time Period should be considering the Fiscal Periods.
Workaround: None.
DE50656
Cosmetic
Found in 15.6
Fixed in 15.7.1

Export to CSV from Status report list page adds one day extra

SUMMARY: Export to CSV from Status report list page adds one day extra when the cop_report_date has
midnight date like '14-JUN-19 23:59:59'.
STEPS TO REPRODUCE:
1. Login to Clarity Classic UX
2. Go to a Project List page and go into project properties page
3. From the Project Properties page go to Status reports list page
4. Add the report date, created date to the status report list page
5. Go to database and run a query
select odf_parent_id, cop_report_date, created_date from odf_ca_cop_prj_statusrpt
where odf_parent_id = 'Replace the Project 5 million ID' ;
6. Observe the output and you will have the date and timestamp
7. Update the created date and report date using the below query - This step is done to get a scenario when
a status report was created during midnight
update odf_ca_cop_prj_statusrpt
set created_date = '14-JUN-19 23:59:59'
where odf_parent_id = 'Replace the Project 5 million ID' ;
8. From the cog wheel of Status report list page Export to excel data only
9. From the cog wheel of Status report list page Export to CSV
Expected Results: The export to excel and export to csv should match what is shown in Clarity UI.
Actual Results: Export to excel is same what is shown in clarity UI but export to CSV adds a day ahead of the
date shown in Clarity UI.
Workaround: None.
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DE50663
Minor
Found in 15.6.1
Fixed in 15.7.1

Flyout width expands on editing field on the flyout and misaligns column picker tab

SUMMARY: Flyout width expands on editing field on grid and board on Chrome and Firefox browser. I am to
reproduce this issue on Mac on FF/Chrome.
STEPS TO REPRODUCE:
Use Case #1: Flyout width expands on editing fields.
1. Click on grid to open Flyout
2. Open flyout and click on any field with dropdown
3. Flyout will expand
Use Case #2: Flyout width expand on creating a new card.
1. On board click on + icon to create a new card
2. Add required fields to create card and press tab
3. Width of flyout will expand
Expected Results: Fly-out width should not expand.
Actual Results: Fly-out width expands.
Workaround: It happens on initialization. Once the user adjusts their personalized settings, the issue does not
continue to occur.
DE50798
Minor
Found in 15.7
Fixed in 15.7.1

When a lookup value for the Sponsor field in the Roadmap Item Flyout is selected, it doesn't stick

SUMMARY: Although the UX does not indicate the selected value for Sponsor is saved, it is saved in the
database. Refreshing the page will show the value sticks as it is saved.
STEPS TO REPRODUCE:
1. Create a new Roadmap
2. Navigate to the Timeline
3. Drag and drop to create a new Roadmap Item
4. In the flyout, click in Sponsor Lookup and select a value
Expected Results: The selected value is displayed in Sponsor field.
Actual Results: The value does not stick, however when user closes the flyout and edits it again, the value is
present.
Workaround: Close the flyout and re-open for editing.
DE50821
Cosmetic
Found in 15.6.1
Fixed in 15.7.1

Queries and portlets are deleted even though they are not associated with the deleted object

SUMMARY: Queries and portlets are deleted even though they are not associated with the deleted object.
In the environment of V15.6.1, a phenomenon where the wrong custom portlet and the associated portlet
query are deleted when an object is deleted.
There is no evidence the portlet and query have been deleted in logs.
STEPS TO REPRODUCE:
1. Create 2 custom master objects
Object (A) n_wf_apply
Object (B) n_wf_ap
2. Create a Query which refers to "n_wf_apply" object (A)
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3. Create Portlet which uses the above query for object (A)
4. Delete "n_wf_ap" object (B)
5. Both query and portlet for object (A) are deleted
They don't relate to "n_wf_ap" object (B). They relate to "n_wf_apply"object (A)
Expected Result: When object (B) is deleted, associated items will be deleted.
Actual Result: When object (B) is deleted, associated items to object (A) are incorrectly deleted.
Workaround: Manually recreate the query and portlet for object (A).
DE50885
Major
Found in 15.6.1
Fixed in 15.7.1

Roadmap sync up Idea has discrepancy in Finish Date

SUMMARY: After syncing an Idea in a Roadmap, when viewing the linked items in the grid, the updated
Finish Date from idea is showing the date + 1 day. But when clicking on the idea link and the detail page
shows the correct date.
STEPS TO REPRODUCE:
Prerequisites: Ensure there is no start and finish date defaults set in the Studio on both Idea or Investment
objects.
1. Create Idea with start date as 9/1/19 and Finish date as 9/30/19 in Classic
2. Navigate to Modern UX and go to Roadmaps
3. Create New Roadmap and attempt to sync newly created Idea
4. Once sync is complete you will see that Start Date is showing 9/1/19 (as expected) but Finish date is
showing as 10/1/19 (+1 day). but when clicking on Idea details in the New UX correct Finish date is
displayed
Expected Results: Finish Date should match what is on the details of the idea.
Actual Results: Finish Date is showing +1 day.
Workaround: If desired, manually update the Finish Date on the Roadmap Item.
DE51005
Minor
Found in 15.6
Fixed in 15.7.1

STAFF 'Allocation' field should NOT appear editable in DETAILS fly-out

SUMMARY: In the Project STAFF grid, the 'Allocation' (scalar) cell in the column is not editable. If you add
the field into the fly-out it appears editable. The user is able to type in a value, however the value is not
saved; it goes back to the original value and no error message appears. The field should not appear
editable.
Note: the ETC scalar field is not editable in both places.
STEPS TO REPRODUCE:
1. Login to Modern Clarity UX
2. Navigate to a Project STAFF grid
3. Click on a row and open the DETAILS fly-out
5. See the ALLOCATION field - type in a number
Expected Results: The field should not appear editable and should not allow entry.
Actual Results: The field allows entry, however the value is not saved and no error is generated.
Workaround: Ignore this field and use the Total 'Allocations' and Per-Period 'Allocations' (with an 's' in the
label).
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DE51006
Cosmetic
Found in 15.5.1
Fixed in 15.7.1

'Update % Complete' doesn't work when added to the 'Actions' Menu

SUMMARY: Actions Menu Error when adding Update % Complete job to the actions. This appears to be
because the OOTB job has special character in the name and that cannot be passed in the parameter.
STEPS TO REPRODUCE:
1. Create Action Item
a. Administration/Project Object
b. Actions tab
- New
Action Name: Update Percent Complete
Action ID: up_per_comp
Type: Job
Select Job: Update % Complete
Instance-specific
2. Add to Views Menu
a. Views tab
b. Project Properties Actions link
c. Add the item here
3. Go to a project and try the link
Expected Result: Link works and job dialog opens.
Actual Result: Link will not open with Error: URL malformed ...
Workaround:
To use this job in an Action Menu, rename the Job. The URL is malformed because the job name has a
special character.
1. Remove (delete) the existing Menu Action
2. Rename the Job from 'Update % Complete' to something that does not have a special character - such as
'Update Percent Complete'
3. Recreate the Menu Action
DE51007
Major
Found in 15.6
Fixed in 15.7.1

ASSIGNMENT ETC value is not spread correctly if the Act Thru date falls within the period

SUMMARY: The amount entered in Modern UX should not be reduced just because there is an Act Thru
date on the assignment. The ETC amount entered should be spread evenly across the period from the date
of the Act Thru Date. The application is trying to spread the amount across the entire period and due to the
business rule where there should be no ETC prior to the Act Thru date, the application is simply dropping that
amount instead of spreading the amount evenly across the remaining working days in the period. It works
correctly in Classic.
STEPS TO REPRODUCE:
1. Have a project that covers the month of September 2019
2. Create a task that covers the full month of September 2-30 (Sept 2 = Monday; working day)
3. Assign a resource to the task for the full month - this will generate 168 hours of ETC for this assignment
(21 working days)
4. Submit a timesheet for 40 hours during the first week of the month ( the time period spans Sept 2 - 8 )
5. After approving and posting the timesheet, the remaining ETC = 128
6. Return to the Project ASSIGNMENTS grid in Modern UX
7. Display the ACT THRU date, the TOTAL ETC, TOTAL ACTUALS and the PER-PERIOD ETC and
ACTUALS
8. In the PER-PERIOD configuration use MONTHLY periods so you can see the amounts for September for
this resource
It shows ETC = 128 for September as expected
It shows ACTUALS = 40 for September
It shows ACT THRU date = Sept 08 2019
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9. Change the ETC from 128 to 80 for September 2019
Expected Results: The total amount for the period should show 80. It should spread the 80 hours between
Sept 9 thru 30.
Actual Results: The amount saved is showing 61 (or 60.95 with 2-decimal display). Looking at the curve in
Classic the date range is correct ; it shows Sept 9-30. It is trying to spread the 80 hours into the entire month
from Sept 1-30. Hence, the amount that would have been spread into Sept 1-8 is dropped due to the Act
Thru date.
Workaround: Go into Classic, Task and for the one month that has the ACT THRU date, enter the value 80
and it saves correctly, applying the full amount to the date range of Sept 9-30.
DE51008
Minor
Found in 15.5.1
Fixed in 15.7.1

Requirement Name is actually getting saved for non-role Staff and should not

SUMMARY: On Project STAFF grid, the user is able to attempt changing the requirement name on a nonrole row (on a resource or team). The application flashes and the value does not appear to be saved
because the display shows the name of the resource or team. However, it really is saved in the database
and thus it can be seen in the pull-down on the ASSIGNMENTS page when adding or replacing an
assignment.
This requirement name shows up on the lookup pull-down when adding an assignment and when doing a
replacement on existing assignment. It also shows up on the ASSIGNMENTS 'Requirement Name' field.
STEPS TO REPRODUCE:
1. Login to Modern UX
2. Go to Project STAFF grid
3. Add a Resource, a Role and a Team
4. Add the 'Requirement Name' field to the grid
5. Edit the Requirement Name field for each of the added STAFF
6. Notice the display for a Role shows the updated text. Notice the display for a Resource or Team, it does
not show the text you entered, but shows the name of the resource or team (as expected)
7. Go to Project ASSIGNMENTS grid
8. If there is an effort task on the project, you will see the 3 staff members already assigned
9. Add the 'Requirement Name' field to the grid
10. Create a new task and in the '*Resource' field use the pull-down to assign any of the STAFF
Expected Results: The lookup pull-down to show the Resource Name or Team Name not some attempted
change to Requirement Name. The Requirement Name field should not allow changes for non-roles.
Actual Results: The attempted change to the Requirement Name on a Resource or Team actually saved the
text and it is showing up on the ASSIGNMENTS grid.
Workaround: Go into STAFF grid, Requirement Name - select the full text and click DELETE. This will cause
the value to be removed from the Requirement Name field and thus in ASSIGNMENTS it will show properly.
Resolution: The API has been fixed so that any attempt to change the Requirement Name on non-roles is not
saved. Although the user can still edit the Requirement Name field for non-roles, the change is not saved as
expected. The desired behavior is for this field to behave as a read-only field in the Modern UX, but this is
not part of this fix. Making the field read-only for non-roles requires additional complex, feature work to
identify row-level and field-level behaviors.
DE51073
Major
Found in 15.7
Fixed in 15.7.1

Navigating to Project Grid in Modern UX and then going to Project Board doesn't display any data

SUMMARY: Navigating to Project grid page in new ux and then going to board view doesn't display any data and
below errors are seen in log
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ERROR 2019-09-10 12:58:06,212 [http-nio-8443-exec-14] ppm.rest (clarity:U0191337:5782040__CC723577399C-4DB9-86FE-C2A3582EDABD:PPM_REST_API) Exception processing request for resource [picklists],
query
string[/private/picklistContexts/5011000/picklists?filter=%28%28objectCode+%3D+%27project%27%29+and+%28
attributeCode+%3D+%27obj_work_status%27%29+and+%28isPicklist+%3D+true%29+and+%28isActive+%3D
+true%29%29]
java.lang.NullPointerException
at
com.ca.platform.osf.object.rest.function.PicklistApi.lambda$prePopulateGlobalPicklists$3(PicklistApi.java:293)
at java.base/java.util.stream.ReferencePipeline$2$1.accept(ReferencePipeline.java:176)
at java.base/java.util.ArrayList$ArrayListSpliterator.forEachRemaining(ArrayList.java:1654)
at java.base/java.util.stream.AbstractPipeline.copyInto(AbstractPipeline.java:484)
STEPS TO REPRODUCE:
The prerequisite for this issue to be reproduced is to ensure you have a lookup attribute in project object and
somehow, due to some data migration the lookup was deleted.
1. Login to Clarity and navigate to Modern UX Project Grid page
2. Navigate to board view or picklists
Expected Results: User should be able to view the projects via board view in Modern UX.
Actual Results: User is unable to see any projects via board view in Modern UX.
Workaround: Run the below queries to find the orphan lookup attribute and fix the orphan attribute association
- Run the first SQL and confirm no Lookups with lower-case IDs.
- Run the second SQL
- Locate any attributes reported as having missing Lookups on the Object Views. Decide whether to keep or
remove the attributes
- For the attributes to keep, create an appropriate Lookup (to match the previous Lookup definition)
- Re-run the SQL and confirm that the attributes to keep are not reported as missing their Lookups
- For the attributes to remove, locate them on Views and remove from the View (all partitions). Republish the
Views
- For the attributes to remove, locate them in the Object definition and remove them from the Object
- Re-run the SQL and confirm that the removed attributes are no longer reported
QUERY #1:
SELECT * FROM cmn_lookup_types
WHERE UPPER(lookup_type) != lookup_type
QUERY #2:
SELECT
o.code object_code
, o_nls.name object_name
, a_nls.name spreadsheet_column_name
, LOWER(a.column_name) clarity_attribute_id
, a.id dim_key
, CASE a.extended_type WHEN 'lookup' THEN CASE a.data_type WHEN 'number' THEN 'lookup_enum' ELSE
'lookup' END WHEN 'boolean' THEN 'boolean_text' ELSE NULL END lookup_type
, CASE WHEN (SELECT sql_text_id FROM cmn_list_of_values WHERE lookup_type_code = a.lookup_type) IS
NOT NULL THEN '[dynamic]:' ELSE '' END || CASE WHEN a.dep_exit IS NULL THEN a.lookup_type ELSE
a.dep_exit END || CASE a.is_multivalued WHEN 1 THEN ':multi_value' ELSE '' END lookup_id
, a.data_type data_type
, lt.lookup_type found_lookup
FROM
odf_objects o
INNER JOIN cmn_captions_nls o_nls ON (o.id = o_nls.pk_id AND o_nls.table_name = 'ODF_OBJECTS' and
o_nls.language_code = 'en')
LEFT OUTER JOIN odf_custom_attributes a ON o.code = a.object_name
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LEFT OUTER JOIN cmn_captions_nls a_nls ON (a.id = a_nls.pk_id AND a_nls.table_name =
'ODF_CUSTOM_ATTRIBUTES' and a_nls.language_code = 'en')
LEFT OUTER JOIN cmn_lookup_types lt ON UPPER(NVL(a.dep_exit, a.lookup_type)) = UPPER(lt.lookup_type)
WHERE
a.extended_type = 'lookup'
AND
(
lt.lookup_type IS NULL
OR
NVL(a.dep_exit, a.lookup_type) != lt.lookup_type
)
DE51120
Major
Found in 15.7
Fixed in 15.7.1

Color Coding is missing in the New UX Staffing for 3 row styles unique to the Resource Workspace

SUMMARY: Color Coding is missing in the New Staffing for 3 row styles unique to the Resource Workspace.
Impacted row styles:
1. Soft booked rows – Should have Blue Background color
2. Inactive rows – Should have Gray Background color
3. Locked investments – Should have Text greyed out

STEPS TO REPRODUCE:
1. Create 3 new projects in Clarity and add the same resource to all 3 projects
- For project2, make the investment inactive (this can be done in Modern UX by clicking on the Details tab
in the project and unchecking Active)
- For project3, lock the investment (one way to do this is open the project in a scheduler tool such as
Open Workbench in read/write and keep it open during the steps)
2. Navigate to the Staffing section of the Modern UX
3. In the Resources to Investments portlet, click on the resource added to the 3 projects above to view the
projects beneath the resource
4. For project1, click on project1
5. In the Detail fly out window that appears, change Booking Status to Soft if not set already
6. View the row colors for project1, project2, and project3
Expected Results: The row for project1 should be blue (since the resource is soft booked), the row for
project2 should be gray (since the project is inactive), and the row for project3 should be read only (since the
project is locked).
Actual Results: All rows are white color.
Workaround: None.
DE51123
Major
Found in 15.6
Fixed in 15.7.1

Assigned tasks are added to a timesheet using Copy from Timesheets option in the New UX if
timesheet is recreated

SUMMARY: All assigned tasks are added to a timesheet in the New User Experience (UX) due to ‘Add
Assigned Tasks’ option being hidden. So far this is only reproducible if the add assigned tasks was checked
when originally creating a timesheet and then the timesheet is deleted and recreated.
STEPS TO REPRODUCE:
1. Create a project (open for time entry and track mode of PPM)
2. Add a resource to the team (ensuring the resource is open for time entry with track mode of PPM)
3. Create 2 tasks on the project (open for time) and assign the resource to both tasks
4. Log in to the New UX as the user added to the project
5. Navigate to the New UX timesheets
6. Create a new timesheet for the user using the + Work to Timesheet option
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7. Select just one task from the project above to add to the timesheet and click ‘Add and Close’
8. Navigate to the next period’s timesheet and this time ensure ‘Add assigned tasks’ is checked
9. Click the – Work button, check the check box next to Select All and then click Delete and Close
10. This brings you back to the Create Timesheet page. Note that the ‘Add Assigned Tasks’ option is hidden
11. Click then ‘Copy previous timesheet’ check box and then Create Timesheet
Expected Results: Only tasks from the previous time period are added to the timesheet.
Actual Results: All Assigned Tasks are also added to the timesheet.
Workaround: Delete all tasks that are incorrectly added.
DE51207
Minor
Found in 15.4.1
Fixed in 15.7.1

Ability to edit the “Text 1” (prusertext1) attribute on the project list.

SUMMARY: Ability to edit the “Text 1” (prusertext1) attribute on the project list. When you choose the "Use
only secured subpages to secure attributes on this list" AVP option and an attribute is on a sub-page that is
not secured but does have a display condition the user cannot edit the attribute when displayed in an editable
grid unless Display condition is met. This issue is reproduced for the Project Object and for the Task Object.
STEPS TO REPRODUCE:
* Steps shown are for Project Object - Repeat Steps for Task Object.
1. Create a new string attribute on the project object or use an existing 'Text 1' (prusertext1) attribute
2. Create a new subpage on the project properties edit page
3. Create a display condition on this subpage
4. Create a section in this subpage
5. Add the new string to this section or an existing 'Text 1' (prusertext1) attribute
6. Modify the Project List layout to show the new string attribute
7. Change the AVP settings on the Project List page to 'Use only secured subpages to secure attributes on
this list'
8. Go to the project list
9. Click into the cell for the new string attribute added in step 1
Expected Results: The cell is editable.
Actual Results: The cell is not editable unless display condition is met.
Workaround: None.
DE51668
Minor
Found in 15.7
Fixed in 15.7.1

Clarity Learn and Help Links Don't work in SaaS

SUMMARY: Help Link doesn't work in Clarity PPM SaaS.
STEPS TO REPRODUCE:
1. Login to Clarity PPM Classic UI
2. On General Page Click on the Help link
Expected Results: A new page opens Referencing to Techdocs.
Actual Results: Nothing Happens.
Workaround: Modify the 'wikiHelp.properties' file for the 'help.restUrl' to point to the correct space.
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DE48508
Major
Found in 15.4.1
Fixed in 15.7.1

Records are Removed from the DWH_INV_ASSIGN_PERIOD_FACTS table in the DWH after Running
an Incremental Instance of the DWH job

SUMMARY: Records are removed from the DWH_INV_ASSIGN_PERIOD_FACTS table in the DWH after
Running an Incremental Instance of the DWH job. This leads to the results in reports using this data, such as
the Resource Allocations and Assignments report being incorrect.
STEPS TO REPRODUCE:
1. Run the 'Load Data Warehouse' job using the Full Load option
2. Once the job completes,
(a) Execute this query (using a valid Internal ID of assignment key) in PPM database and confirm it returns x
number of rows.
select * from DWH_INV_ASSIGN_PER_FACTS_V where ASSIGNMENT_KEY in (5142739)
(b) Execute the equivalent query (using a valid Internal ID of assignment key) in the DWH database and
confirm it returns the same x number of rows:
select * from DWH_INV_ASSIGN_PERIOD_FACTS where ASSIGNMENT_KEY in (5142739)
3. Go to the project having the task with this assignment.
4. In the Gantt, create a new task at the bottom of the list. Leave all the defaults, assign any resource, and
change the ETC to 5 hours. Save the change, and click on Save and Return
5. Look for the task that has the assignment from the two queries above
6. Make any change to the TASK, such as Close or Open for Time Entry, Save and Return
7. Run the Time Slice job - this step is optional and not required to reproduce the issue
8. Run the Load DWH incremental job
Expected Results: The two queries above still return the same results.
Actual Results: The PPM query returns the same results, but the DWH query returns 0 rows.
Workaround: Run the Load Data Warehouse Job with the 'Full Load' option instead of incremental.

DE50575
Minor
Found in 15.5
Fixed in 15.7.1

Action items are editable when the URL is modified

SUMMARY: Action Items for which the user cannot normally edit via the UI, can be edited if the URL is modified.
STEPS TO REPRODUCE:
1. Log in as User1
2. Go to Home - Organizer
3. Under the Action Items tab, click on New
4. Enter the required fields and select a different user (User2) to assign the Action Item to
5. Click on Save and Return
6. Login as User2
7. Go to Home - Organizer
8. On the Action Items tab, click on New
9. Enter the required fields and save the Action Item
10. On the Action Items list, open the Action Item that was created by User1 on Steps 3-5
Notice that there is no Edit button on the bottom of the Action Item details to edit the Action Item
11. Copy the internal action item ID from the URL. Example: 5004001
Sample URL:
http://<clarityServer>/niku/nu#action:calendar.actionitemDetails&odf_pk=5004001&odf_view
=actionitemDetails&cancelAction=calendar.actionItemList
12. Back on the Action Items list, open the Action Item created by User2 on Steps 8-9
Notice that this Action Item is editable as the Edit button appears on the page
13. Click on the Edit button
14. Replace the action item ID on the URL with the ID of the first action item
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Original URL after clicking on Edit button:
http://<clarityServer>/niku/nu#action:calendar.actionitemProperties&odf_pk=5004002&odf_view
=actionitemUpdate&returnAction&uitk.session.uuid=538b3e73-82f3-4cad-a0bc-962aeaa9bbd7
Updated URL with other Action Item ID:
http://<clarityServer>/niku/nu#action:calendar.actionitemProperties&odf_pk=5004001&odf_view
=actionitemUpdate&returnAction&uitk.session.uuid=538b3e73-82f3-4cad-a0bc-962aeaa9bbd7
Expected Results: The edit page does not come up for the Action Item that User2 should not be able to edit. No
edits are allowed to be saved.
Actual Results: The edit page comes up for the Action Item that was assigned to User2 that he should not be able
to edit. Edits made to the Action Item can be saved.
Workaround: None.
DE51468
Major
Found in 15.6.1
Fixed in 15.7.1

Spanish Language setting displays the date on any Board Card Face or Tasks Timeline with an extra
number

SUMMARY: When accessing the Modern UX and with a user language set to Spanish, the Project Board, or Idea
Board, or Task Board, shows an incorrect number at the Finish Date. This happens on the Tasks Timeline too in
15.7.

Example: For February 16, 2020 - the date should appear as 16 feb., 2020
However, it is showing as '16 06 feb, 2020' on the card.
If you open the DETAILS fly-out you will see the date is correct; it shows feb. 16 2020
NOTE: Both the Language and the Locale Account Settings determine the format for the dates in the Modern
UX.

STEPS TO REPRODUCE:
1. Set your Account Settings for Language = Spanish and Locale = Spanish (Spain)
2. Go to the Project Board, or Idea Board or Task Board and look at the Finish Date on the card face
3. In 15.7 go to the Tasks Timeline view and look at the date fields there
Expected Results: For the date to appear correctly.
Actual Results: There is an errant 2nd number on the date field.
Workaround: None.
DE49979
Minor
Found in 15.6.1
Fixed in 15.7.1

Unable to Add Role to Staff List in Modern UX when there are more than 25

SUMMARY: We have many resources that use a specific role as their primary role (more than 25 people use this
role). The pull-down is unusable for selecting the appropriate role unless you search for the unique ID which will
narrow the results down to 1 result. Although the pull-down will allow us to search by primary role, the results we
get back is more than 25. Therefore, the one record we may want to add is not visible and we can't easily figure
out how to get to that one record. This used to work on prior versions, but after upgrading it no longer works.
There is no workaround other than using the Classic UI for selecting the appropriate role.
STEPS TO REPRODUCE:
1. Create a role with a name that starts with a letter later in the alphabet, for example, 'Test Role'
2. Add this role as the Primary Role of at least 25 active resources that all have a last name starting with a letter
earlier in the alphabet, for example, 'Amos - Jones'
3. In the Modern UX, go to the STAFF module on any project
4. Click on the plus (+) sign to add a new team member
5. Type in the name of the role created on Step 1
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Expected Results: The role created on Step 1 comes up on the list and is available to add to the project team.
Actual Results: The role does not come up on the list. Only the top 25 resources (with their last name in
alphabetical order) having this role as their primary role are available to add to the project team.
Workaround: If the role or resource unique ID is known that can be used to find the one specific record.

Resolution Note:
Resolved in 15.7.1 - Not a candidate for a Patch in prior versions.
DE51469
Minor
Found in 15.4.1
Fixed in 15.7.1

ERROR 'Value is too large' for the Resource on the Assignment Properties

SUMMARY: The assignment properties page can not be modified/saved if the Resource/Role associated with the
assignment has a name exceeding the limit of 64 bytes. In Classic, a red error message 'Value Too Large'
appears with a yellow triangle icon next to the 'Resource' field. In the Modern UX ASSIGNMENTS grid, an
internal processing API error is thrown.
STEPS TO REPRODUCE:
1. Login to Classic PPM as an Administrator user
2. Create a new Resource
Go to Home, Resource Management, Resources
Click 'New' button
3. Select 'Role' and 'Labor', click 'Next' button
Role Name = 'A really really really really really really really really really really really long role name'
Role Id = 'really_really_really_really_long'
Click 'Submit' button
4. Add the newly created Role into a task assignment in a Project
Go to Home, Projects, Select an existing Project
Project, Team, Staff, Add the new Role to the Project
Project, Tasks, Task List, Add a new Task
Assign the new role to the Task
5. Click on the Role's Assignment Properties Icon
6. Modify the Assignment Dates or the ETC
7. Click 'Save' or 'Submit' button
Expected Results: Modifications should be saved without any errors or issue.
Actual Results: A red error message 'Value Too Large' appears with a yellow triangle icon next to the 'Resource'
field.
Trying to update the assignment ETC Per-Period metrics for this resource, in Modern UX, causes an API
error: API-1019: Could not process the request due to internal error.
Workaround: None.
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DE51322
Major
Found in 15.7
Fixed in 15.7.1

Projects and Ideas Filter Views are Missing Settings after Upgrade to 15.7

SUMMARY: After upgrade to 15.7 our filter Views for project and ideas are messing in the New UX.
STEPS TO REPRODUCE:
Prerequisites: You need 15.6.1 environment
1. In 15.6.1 navigate to Modern UX and go to Project and Ideas Grid View
2. Create and Save some Views with Filters, for example, 'My Approved Projects' and 'My Rejected Projects', do
same for Ideas 'Ideas to Approve' and 'My Unapproved Ideas'
3. Upgrade this environment to 15.7
4. Navigate back to New UX -> Projects and Ideas
5. Notice View are present but Filters are missing
Expected Results: Filters should be retained
Actual Results: Filters are missing after the upgrade
Workaround: None

Resolution Notes:
1. Upgrades to 15.7.0 from 15.6.1 or any previous version have a multi-step upgrade.
Reference KB Article 140146 : https://ca-broadcom.wolkenservicedesk.com/external/article?articleId=140146
2. Upgrades to 15.7.1 from any previous version do not have extra steps as part of upgrading to this release.
DE51515
Minor
Found in 15.7
Fixed in 15.7.1

Scrollable Dropdown fields not correctly displayed if located at the bottom of the screen

SUMMARY: Fields placed at the bottom of the screen, which is of a scrollable searchable drop-down type, are
not getting correctly displayed. The popup/drop-down scrollbar display box is hidden at the end, so the values are
not visible.
STEPS TO REPRODUCE:
1. Login to Clarity PPM as an Administrator user on the new UX
2. Edit/Modify an existing Blueprint on the Administration section
3. The Details section, add content/fields to the different sections, to make sure of filling a complete screen
4. Add a field at the bottom of the Blueprint, which is a searchable dropdown
5. Publish the changes
6. Open a Project associated with the modified Blueprint
7. Go to the Details section of the Project
8. Click on the searchable dropdown field located at the end of the screen
Expected Results: The dropdown list with the scroll bar to list the values, on top of the field.
Actual Results: The dropdown list with the scroll bar to list the values is displayed below the field, and is hidden at
the bottom of the screen. The displayed values can be hardly seen/selected.
Workaround: Place the field on a different section/place on the Blueprint.
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DE49875
Major
Found in 15.6.1
Fixed in 15.7.1

The Resource Requisitions list view throws a system error when a calendared time-varying attribute is
added to the view

SUMMARY: Classic PPM Only. The Resource Requisitions list view throws a system error when a user-defined
calendared time-varying attribute is added to the view.
STEPS TO REPRODUCE:
1. Go to Studio > Objects > Requisition object
2. Go to the Attributes tab
3. Create a time-varying type attribute
Name: MyTV attribute
Data Type: Time-varying
Time-varying Type: Calendared
Time-varying Data Units: Number
4. Go to Views > Edit Requisition > [Layout: Edit]
5. Add the attribute to the General section
6. Go to any given project team tab
7. Select a team member and through the Actions menu create a requisition
8. Go to Team > Requisitions
9. Edit the Requisition and populate the custom time-varying attribute
10. Save and Return
11. Go to Home > Resource Management > Resource Requisitions
12. Through Options > Configure > List Column Section, add the MyTV attribute to the list view
13. Save and Return
Expected Results: The attribute to be added to the list view and display its values.
Actual Results: System error. Contact system administrator. The app-ca.log file generates an internal Processing
exception for java.lang.NumberFormatException.
Workaround:
1. Publish the Requisition Object views (This restores the list view to every user).
2. Through Administration > Studio > Views, find the affected list view and publish the single view (This restores
the list view to every user).
DE51526
Major
Found in 15.7
Fixed in 15.7.1

Create Instance Right is not working for custom sub-objects

SUMMARY: The create instance right is not working custom sub-objects. In the STR, I am using the Status
Report sub-object, but it could be any custom sub-object.
STEPS TO REPRODUCE:
1. Create a user and give them global project/project tiles/project management - Navigate rights
2. Grant the user instance view access to the eCommerce Portal project
3. Go to the eCommerce Portal project and go to Properties->Main->Access to Project->Resources and click the
"Add" button
4. Search for "Project - Create - Status Report" and click "Add and Continue"
5. Select the user created in step #1 to get assigned the Create Status Report instance right
6. Go to the ModernUX and access the eCommerce Portal project and go to the Status Report grid
7. Create a status report
Expected Results: Users should be able to create a status report instance.
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Actual Results: User gets, "API-1007 : You are not authorized to process request. Contact your system
administrator for necessary security rights." error.
Workaround: None.
DE51172
Major
Found in 15.6
Fixed in 15.7.1

Participants appear multiple times on the Project > Team Participants view if system groups are added

SUMMARY: In Classic PPM, Participants appear multiple times on the Project, Team Participants view if system
groups are added. The Team Participants - All view also shows duplications.
This seems to be a consequence of a fix implemented for DE49895: Using a System Group in one Project
Participants is showing the resources in ALL Projects.
STEPS TO REPRODUCE:
1. Create a System Group through Administration, Organization and Access: Groups
2. Add a few resources to the group
3. Create a project
4. On the Project, Team tab, Participants menu, Add the System Group
5. If you navigate to the Team, Participants, Resources menu, you see the user who created the project
appointed as Collaboration Manager and the team members part of the group
6. Mark the project as a template
7. Create a new project based on the above template
8. Go to the team tab on the newly created project and check the Participant list
Expected Results: The Resource view shows participants once.
Actual Results: The participants are displayed multiple times.
Workaround: None. This is a display issue; the data is not duplicated.
DE50816
Minor
Found in 15.6
Fixed in 15.7.1

Hint on a List Filter Field with Display Type set to Numeric Range is displayed twice

SUMMARY: Hint text on a List Filter Field with Display Type set to Numeric Range is displayed twice.
STEPS TO REPRODUCE:
1. Add an attribute to a Custom Object with Data Type as Number
2. Add the Attribute to the List Filter View. Move in the Layout to the list of Selected fields
3. Select the field on the List Filter view. click on [Fields]
Object: <Custom Object> | Partition: System | View: <Custom Object> - List Filter Field
4. Click on the Properties icon of the field
5. Change Display Type from "Text Entry" to "Numeric Range"
6. Enter some text on the Hint for the field
7. Display the list of the Custom Object (Home => Custom Objects)
8. Expand the Filter section on the "Custom Object" list
Expected Results: The hint configured on the field to be displayed just one on the view.
Actual Results: The hint is displayed twice (once for each field for the range).
Workaround: One idea is to use a tool-tip, however, it only displays when the user is using the field.

DE51432
Minor
Found in 15.7
Fixed in 15.7.1

Idea Converts but the blueprint field is blank as the Idea Blueprint ID is invalid for Projects

SUMMARY: Convert Idea copies the Idea Blueprint value into the Project Blueprint field. The value is stored in
the Project's Blueprint field which causes a problem because this 'Idea' blueprint is not valid for a Project.
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STEPS TO REPRODUCE:
1. Login to Modern UX
2. Create an Idea
3. Associate the Idea to any Idea Blueprint
4. Submit/Approve the Idea
5. Convert Idea as a Project
6. Repeat steps as above but convert using a project template where a Project Blueprint ID is associated
Expected Results: Idea Converts but the blueprint field is blank as the Idea Blueprint ID is invalid for Projects. If
project template is used, Project Blueprint (from template) is populated.
Actual Results: Idea Converts and the project contains the Idea Blueprint ID.
Note: The value is not visible from the project properties page as it is invalid lookup value for projects. However it
does show on the Project List page as well as in inv_investments.
Workaround: Update the Blueprint IDs manually.

DE50718
Minor
Found in 15.6
Fixed in 15.7.1

XOG in of Project Instances fails on the Lookup - Risk Rating (Standard - LMH)

SUMMARY: XOG in of Project Instances fails on the Lookup - Risk Rating (Standard - LMH) when adding a new
value to the lookup.
STEPS TO REPRODUCE:
1. Administration > Lookups > Risk Rating (Standard - LMH)
2. Add new Risk Rating Value (e.g. Very High, 150)
3. Create new project
4. Edit Risk subpage: use the new value in one of the risk category fields (Very High); click save
5. XOG out this project instance using the prj_project_read.xml template
6. XOG in this project instance
Expected Result: XOG writes the new project into Clarity
Actual Results: XOG fails with a 'bad value' error message
<ErrorInformation>
<Severity>FATAL</Severity>
<Description>[Error] :1:1: attribute "sponsorshipRisk" has a bad value: the value is not a member of the
enumeration: ("0"/"100"/"50")
Invalid attribute in input document. Please remove all instances of attribute from document elements and try
again.
[Element : Project, Attribute : sponsorshipRisk ].
</Description>
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<Exception type="java.lang.Exception">Invalid xml data</Exception>
</ErrorInformation>

Workaround: None. Alternately - remove this value from the XOG and then manually update it in UI.

DE50296
Minor
Found in 15.5
Fixed in 15.7.1

Delete Log Analysis Data Performance Issue

SUMMARY: The 'Delete Log Analysis' Job is taking a long time to complete. Performance is degrading when the
table has a relatively large number of records (>9 million).
STEPS TO REPRODUCE:
1. Login to Clarity PPM
2. Ensure that Tomcat Analysis job is running for more than 30 days and that daily there are at least 300K
requests that get handled
3. On 30th Day the count of LOG_DETAILS table should be around 9 million rows
4. Delete Log Analysis job is scheduled to remove Log entries greater than 30 days
Expected Results: Job completes within a reasonable amount of time.
Actual Results: Performance degrades as the LOG_DETAILS table is too large and each DELETE operation
consumes significant amount of Database Time, User I/O.
Workaround: None.
DE51215
Minor
Found in 15.4.1
Fixed in 15.7.1

The Time Slicing job is failing when setting a zero (0) periods defined on some slices

SUMMARY: The Time Slicing job is failing when setting zero (0) periods defined on some slices.
Setting zero periods on the DWH fiscal slices does not cause any error.
team::alloccost_curve::dwh_fiscal
team::hardallccost_curve::dwh_fiscal
assignment::prestcurve::dwh_fiscal
team::hard_curve::dwh_fiscal
assignment::practcurve::dwh_fiscal
baseline::current_team_cost::dwh_fiscal
baseline::current_assignment_usage::dwh_fiscal
resource::pravailcurve::dwh_fiscal
baseline::current_team_usage::dwh_fiscal
baseline::current_assignment_cost::dwh_fiscal
team::pralloccurve::dwh_fiscal Fiscal
assignment::etccost_curve::dwh_fiscal
assignment::actcost_curve::dwh_fiscal
It is however causing issues modifying those other ones:
assignment::actcost_curve::dwh_month
assignment::etccost_curve::dwh_month
team::alloccost_curve::dwh_month
team::hardallccost_curve::dwh_month
baseline::current_team_cost::dwh_month
baseline::current_team_usage::dwh_month
assignment::actcost_curve::dwh_week
assignment::etccost_curve::dwh_week
team::alloccost_curve::dwh_week
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team::hardallccost_curve::dwh_week
baseline::current_team_cost::dwh_week
baseline::current_team_usage::dwh_week
STEPS TO REPRODUCE:
1. Login as a Clarity Administrator.
2. Administration => Data Administration => Time Slices
3. Select The Time Slice Name: assignment::etccost_curve::dwh_month
4. Open the slice definition and change the Number of Periods to zero (0), save and confirm changes
5. Execute 'Time Slicing' job
Expected Results: The Time Slicing job to run successfully.
Actual Results: The Time Slicing job fails with the exception 'java.lang.IndexOutOfBoundsException: Index: 0,
Size: 0'.
Workaround: Define at least 1 period for each Time Slice Definition.
DE51355
Cosmetic
Found in 15.7
Fixed in 15.7.1

Read Only attributes based on lookups with Source 'Dynamic Niku Query' are not greyed out in the
Modern UX

SUMMARY: Read Only attributes based on lookups with Source 'Dynamic Niku Query' are not greyed out in the
new UX. The field is displayed in such a way that it permits to select a value for the attribute. However, it is not
getting saved. This is very confusing for the end users, as they think they might be able to select values for those
fields. Static lookups work as expected. The steps below have both types of lookup fields for comparison.
STEPS TO REPRODUCE:
1. In Classic UI, add a new attribute on the Project object in Studio
2. Attribute#1 is created using a Dynamic Query Lookup - Name the attribute 'Test Blueprint'
Associate it to the Out of the Box Lookup, Blueprints
Mark it as Read-Only
Configure the API Attribute ID, 'z_test_blueprints'
On the Object Attribute ID for the Lookup Parameter Mappings enter 'investment_type'
Save the attribute
3. Attribute#2 is created using a Static Lookup - Name the attribute 'Test Static Lookup'
Associate it to a stock Static Lookup
Mark it as Read-Only
Configure the API Attribute ID, 'z_test_static'
Save the attribute
4. On Modern UI, edit a user-defined Project Blueprint
5. Add the new fields, 'Test Blueprint' and 'Test Static Lookup' to the Blueprint (for instance on the Project
Summary section)
6. Publish the changes on the Blueprint
7. Open a project associated to the Blueprint just modified
8. Both fields are displayed on the Details Module in the Project Summary section
9. Try to edit either field
Expected Results: Both attributes 'Test Blueprint' and 'Test Static Lookup' to be greyed out. Should not have the
ability to edit the read-only lookup fields.
Actual Results: The Dynamic Query Lookup 'Test Blueprint' is NOT greyed out and it is possible to display the list
of values for the field; therefore, the user thinks the field is editable when it is not. The static lookup is greyed out
and working as expected.
Workaround: None.
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DE51277
Major
Found in 15.6.1
Fixed in 15.7.1

New UX pop-up error: Error Retrieving Instances

SUMMARY: New UX pop-up message: Error retrieving instances. Even though that message is getting displayed,
there appears to be nothing wrong with the application. It is not logging any errors either on the app log files.
STEPS TO REPRODUCE:
1. Log in to the new UX as administrator
2. Go to Projects
3. Move from Grid to Board views a few times quick enough
Expected Results: The application displaying the data (loading it) whenever it has enough time to do it.
Actual Results: The application displaying the data (loading it) whenever it has enough time to do it, but the
message "Error retrieving instances" is getting displayed at some times.
Workaround: None.
DE50563
Minor
Found in 15.6
Fixed in 15.7.1

Phoenix UI - Long Project names leads to Overlay of Dropdown Menus

SUMMARY: A long project name overlays the drop-down tab action menus - such as 'Open in Scheduler',
'Scenario', 'Actions'.
STEPS TO REPRODUCE:
1. Create a project in the system with name within the allowed limit - 80 characters.
e.g. 'Mobile Device Management (MDM) Deployment and Maintaining Mobile Managements Syst'
2. Check the chrome browser zoom level, it is usually at 100%. Else increase the zoom level to anything over
75%
3. Open the project view with Phoenix UI theme applied, and hit on the project properties tab you would notice
menu buttons having an overlay with the Project name
Expected Results: The project name to not overlay the menu options.
Actual Results: The project name overlays the menu options on the Phoenix UI - the name runs into the 'Open in
Scheduler' link.
Workaround: Use 100% zoom and recommended, standard monitor display resolutions.
DE49763
Major
Found in 15.4.1
Fixed in 15.7.1

Unclear Modern UX Error Messages

SUMMARY: Some messages in the New User Experience don’t give a correct indication of the issue or what the
customer is trying to do.
Some examples:
No Resources found message that is generated. This can happen due to performance issues, such as in the
below scenario, and makes the user think that there was a problem loading the resources, but rather it is just
taking some time to complete the request.
STEPS TO REPRODUCE:
1. Go to Modern UX as a user with timesheet edit rights for other users
2. Click on the Timesheets icon
3. Click on the magnifying glass to search for a different resource
Expected Results: If it takes a long time to load the resources, a message appears similar to 'Loading resources,
please wait'.
Actual Results: If it takes a long time to load the resources, a message appears 'No resources found'.
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Note: In an out of the box environment, you can see the message appear for a millisecond if you look quickly, but
for customers, it can show up for a while if they are seeing performance issues. The message causes confusion
as they think they’ve lost access to the resources, or there’s some other data issue occurring. The word
'resources' in the error messages is causing confusion with end-users because they think the word 'resources'
refers to the 'resource' object instance data ; not the API 'resource' for which the error message uses.
Workaround: None.
DE49803
Major
Found in 15.5.1
Fixed in 15.7.1

Open Workbench Crashing When Manually Adding Tasks to Project

SUMMARY: When inserting tasks into an existing WBS (in the middle, not at the end), after you insert 2 on the
third the program either errors or just closes itself out.
There is a workaround, but it's hard to remember to do it. If the user forgets to do the workaround and instead just
do the steps that cause the issue, they sometimes lose up to hours of work as they have to completely closed out
of OWB and start over.
STEPS TO REPRODUCE:
1. Use a project that has a few tasks. They can all be at the same level
2. Open the project in OWB
3. Click on one of the middle rows and click Insert (either on OWB or keyboard)
4. Enter task ID and name
5. Click insert again
6. Repeat 2 or 3 more times
Notes:
Sometimes you can insert 2 but after 3 you usually get the error
You can also just try clicking on insert to insert new lines before you type in task info
Expected Results: You can insert new lines.
Actual Results: Either get noWbench.exe has stopped working or OWB just closes. Nothing in the logs.
Workaround: Instead of using the insert functionality, if you need to insert a new task not at the bottom of the
project:
1. Add the new task at the bottom of the project
2. Highlight the entire new task
3. Left click in the task name, which will enable the move functionality
4. Drag the task to the desired location.
DE47803
Minor
Found in 15.4
Fixed in 15.7.1

Parameterized Lookup in Risk Object Using Lookup Parameter Mapping: ID to PK_ ID doesn't work
properly

SUMMARY: Parameterized Lookup in Risk Object Using Lookup Parameter Mapping: ID to PK_ ID doesn't work
properly. This issue is reproduced for the RISK, ISSUE, CHANGE REQUEST stock sub-objects. The same
lookups work correctly for custom sub-objects.
STEPS TO REPRODUCE:
1. Create a custom object
2. Create some instances of the custom object
3. Create a dynamic lookup that retrieves the instances of the custom object
4. Go to the Project Object and create a new attribute using the new dynamic lookup and place the lookup on the
properties page (PrjLookup1)
5. Create parameterized dynamic lookup
6. Go to the Risk Object and create a new attribute using the new parameterized dynamic lookup
- Set the Parameter Mapping to the PK_ID
- Add the attribute to the Risk properties page (RiskLookup1)
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7. Create Project X and select values from the 'PrjLookup1' field
8. Create Project Y and select values from the 'PrjLookup1' field
9. Go to Project X and create a new RISK
10. Browse in the Risk parameterized lookup field 'RiskLookup1'
Expected Results: Values displayed in the browse should only show ones based on the parameter for this
project.
Actual Results: Values for all projects are displayed in the browse.
Workaround: None.
DE48663
Cosmetic
Found in 15.4
Fixed in 15.7.1

Error while accessing old version of KS documents due to URL being stripped down

SUMMARY: Error while accessing old version of Knowledge Store documents due to URL being stripped down
when scrolling through pages.
STEPS TO REPRODUCE:
1. Login to Classic PPM as an Admin and navigate to Home, Knowledge Store
2. Create Document Versions folder
3. Add a doc_versions.txt document
4. XOG out that document (attached sample used)
5. XOG at least 3 pages worth of versions for this document
6. Now click on Versions under Actions for doc_versions.txt file and attempt to go to page 2, 3 and so on
Expected Results: You should be able to navigate to different pages without any errors.
Actual Results: You are unable to navigate through pages past page 2. When going to page 3 notice your URL
will look like this 'http://myClarityHost/niku/nu#' stripping everything from it.
Workaround: None.
DE49035
Major
Found in 15.5.1
Fixed in 15.7.1

IAD Add-in is not accepting Resource terminationDate NULL in the input feed file and throwing an error

SUMMARY: The business need is to update the resource 'terminationDate' to NULL, IAD is SAAS-only add-in
which allows to get the feed in flat file and update the resource data.
STEPS TO REPRODUCE:
1. Have a SAAS instance
2. Ensure IAD add-in is installed
3. Ensure to have an SFTP
4. Have the feed file with the information of resources
resourceId|firstName|lastName|emailAddress|hireDate|terminationDate|employmentType|inputTypeCode|
managerUserName|~OBSAssoc_ABC_OBS_MANAGEMENT
ab99999|ab99999|ab99999|ab99999@mycompany.com|"null"|"null"|Employee|ABC_0000000000||/One,
Employee (eo999999)/Two, Employee (et999999)
5. Run the IAD Job
Expected Results: The IAD job should complete successfully without errors.
Actual Results: The IAD Job fails with an error in the log file: 'Could not parse given date for column hireDate.
Line: 2. Value: null.
Workaround: None.
DE51094
Cosmetic
Found in 15.6
Fixed in 15.7.1

Adjusted Timesheet ETC Incorrect in Modern UX

SUMMARY: In the modern UX, the timesheet ETC is incorrect after adjusting a timesheet where the ETC had
decremented down to 0 hours.
STEPS TO REPRODUCE:
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1. Create a project
2. Staff a resource to the team
3. Create a task having any dates (example: 9/16-9/20)
4. Assign a resource having Front Loading Pattern and a total ETC of 16 hours
5. Post a timesheet in the modern UX having 16 hours for this task to bring the ETC down to 0
6. In the Modern UX timesheet, go back to the POSTED timesheet - click on Adjust
Expected Results: A timesheet adjustment gets created with the previous 16 hours on the Total column and 0 on
the ETC column.
Actual Results: A timesheet adjustment gets created with the previous 16 hours on the Total column as well as 16
hours on the ETC column.
Workaround: Manually clear out the ETC.
DE50064
Major
Found in 15.1
Fixed in 15.7.1

Tomcat Analyze Job is causing library cache lock in the Oracle database specially in SAAS where there
are more than 60 customers on one database

SUMMARY: Tomcat Analyze Job is causing library cache lock in the Oracle database specially in SAAS where
there are more than 60 customers on one database
STEPS TO REPRODUCE:
1. Have a database which host at least 20 customer environments
2. Schedule the Tomcat Analyze Job at the same time across customer environments
3. Observe the AWR report
Expected Results: The job runs properly however it shouldn't cause library cache lock.
Actual Results: The job runs fine however it causing library cache locks.
Workaround: None.
DE51149
Major
Found in 15.7
Fixed in 15.7.1

Financial Planning access rights do not exist for the Custom Investment object instances

SUMMARY: When a new Custom Investment Object is created, it is expected for the Financial Planning access
rights to be created so they can be assigned to users. These financial plan rights for Cost Plans and Budgets are
missing (don't exist) on the custom investment object instances after upgrade to 15.7
STEPS TO REPRODUCE:
1. Login to Clarity using administrator access
2. Navigate to Administration, Studio: Objects
3. Create a new Custom Investment type object with the 'Investment Extension'
4. Navigate to Administration, Resources and grant the newly created custom investment type rights to the user
Expected Results: Administrators can assign financial planning rights for Cost Plans and Budget Plans to the
user.
Actual Results: Administrators cannot see the below rights as they are missing post upgrade.
<Custom Investment> - Cost Plan - View All
<Custom Investment> - Cost Plan - View
<Custom Investment> - Cost Plan - Edit All
<Custom Investment> - Cost Plan - Edit
<Custom Investment> - Budget Plan - View All
<Custom Investment> - Budget Plan - View
<Custom Investment> - Budget Plan - Edit All
<Custom Investment> - Budget Plan - Edit
<Custom Investment> - Budget Plan - Approve All
<Custom Investment> - Budget Plan - Approve
Workaround: Use the attached DB patch to seed the financial rights
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